What's New in FlexPro 2019
FlexPro 2019 filters and analyzes your data during import and dynamically embeds individual results in the final
report of a series measurement. This document provides a detailed description of all the new features in FlexPro
2019. Take a look in particular at the File Import, File Indexing, Data Preview and Documents sections below.

New User Interface and FlexPro Project Database Features
 Display and Help Language
You can now change the language of the FlexPro user interface and online help under File > Options > Language
and Region without having to reinstall the program.
 File Import General Enhancements
 For most import formats you can now assign a preferred curve color and format at the time the data is
imported so that this preference is used when the data is displayed in a diagram or table. The attributes are
read from the file to be imported as long as they are stored in the file. The result is that the data in FlexPro is
displayed in the same color and format as it is on the measuring device.
 For most import formats you can specify an FPScript code which post-processes the imported data before it is
stored as data sets.
 Quickly define channel selection filters to import a particular channel selection from files.
 Apply an analysis template to data directly while importing files or from Data Explorer.
 When importing HIOKI files, the device name is now imported as a parameter.
 When importing TDM/TDMS, HDF5, MDF4, MDF3, iFile and netCDF files, it is now possible to transfer the data
structure hierarchy.
 When importing netCDF files, 2D data sets can now be imported transposed.
 In the dialog box used to check units, you can now view all data sets for which no unit is noted in the file and
add the missing units as needed.
 Text Data Import
 TextImport now also supports complex numbers.
 With TextImport you can now easily import files in which each Y column has its own X column.
 TextImport now also supports files, such as configuration files, which only contain parameters.
 When importing parameters with TextImport, you can now specify the data type to use.
 When importing text files that contain only one line, you can now specify whether it should be imported as a
scalar value or data series.
 You can now access the imported parameters of the file to calculate a custom X data set.
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 For automatic data set detection of the text to be imported, you can now specify the number of the lines to be
analyzed.
 The option Ignore delimiters at the beginning of a line is now disabled by default.
 New Import and Export Options
 FlexPro can now import and export Microsoft Excel XLS and XLSX file formats directly. The new Excel File
Import Wizard provides you with a set of features that are similar to the Text Data Import Wizard.
 New import filter for BLF, ASC and DBC vector file formats.
 The FlexPro data exchange format now includes the curve color as an additional attribute.
 You can now export your presentations directly to PDF.
 There are now more flexible options for exporting data in text and CSV formats. You can individually compile
the header data to be exported, set the character encoding and the decimal separator. A preview is now
displayed in the dialog box.
 Folder Activation
 Now you can specify whether or not the entire line of the parent folder should also be activated automatically
when activating a subfolder.
 Two commands Activate Next/Previous Folder have been added, which you can use to easily change the
measurement for which an analysis is to be performed.
 File Indexing Enhancements
 Define calculations for files in which you have access to all channels in the currently indexed file and can
therefore carry out cross-channel calculations.
 Use the channel selection filter when assigning file types to folders and files so that you can restrict the
channels to be indexed.
 You can now use drag-and-drop to drag individual data sets from Data Explorer and drop them into a
presentation object, such as a diagram.
 In the Indexing Details dialog box you can now also view the elements already indexed.
 FlexPro can save the data of small data sets in the index database, which speeds up subsequent access. You
can set the maximum number of values in the Options dialog box on the File Indexing tab.
 New Data Preview
The new Data Preview window shows you the data set currently selected in the Object List or Data Explorer as a
diagram. You can use the data cursors to measure the data set without having to create a diagram. Accordingly,
there is now a Display tab in the window of an open formula or of a data set which displays the data as a
diagram.
 General Enhancements
 The Organizer dialog box now also supports the simultaneous import of multiple text import schemas.
 The comments of data sets and other objects can now be entered on more than one line.
 There is now a button on the Options > Messages tab that you can use to re-enable all messages.
 The dialog box for restoring a project database has been redesigned.
 You can now open bit mask object properties in the Properties window, such as the Model property of the
Approximation analysis object, to change the individual bits.
 The line width, dashes and fill style controls in the ribbon now also support the Automatic option.
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New Presentation Features
 Diagrams
 For diagrams with stacked columns or bars, the curves are now output in the legend and on the axis in the
same order in which they appear in the diagram. The Axis Labeling and Legend tabs of 2D and 3D diagrams
now include the Reverse order attribute.
 When exporting a diagram as an image file, you can now predefine the diagram size regardless of the current
size displayed on the screen.
 You can now set the option to extend the axis scaling to the next full division separately for the start value and
end value.
 Now you can also display the drawing grid when drawing in diagrams and use the grid for positioning.
 The Diagram Wizard now has an additional Polar transformed display option, which transforms data sets with
identical Y and X units into polar coordinates.
 For axes of 2D diagrams with scales at both margins of the diagram, you can now specify an alternative unit for
the second scale, e.g. m/s instead of km/h.
 Use the new Point symbol type to display scatter plots. The Diagram Wizard uses this symbol type
automatically for large data sets with scatter data.
 The attributes Visible, Autoscale, Cursors, Axis Label, Legend and Autostyle can now be set directly on the 2D
and 3D Diagram Tools tab of the ribbon.
 Tables
When exporting a table as an image file, you can now predefine the table size regardless of the current size
displayed on the screen.
 Documents
 Use the new Document Collection function to search for documents and embed them in a main document.
This makes it very easy to create a document that bundles existing documents.
 You can now add a table of contents and table of figures to your documents.
 You can use the command Add Label to add a label to diagrams, tables and images that you have embedded in
a document.
 You can now individually position diagrams and tables on each page of multipage diagrams and tables. In the
case of tables, the height can also be adapted to each page. For example, you can start a table in the middle of
the first page and continue it at the top of the next page.
 For multipage diagrams and tables as well as document collections and TOCs, you can now specify whether the
required subsequent pages should be added to the document automatically as virtual pages.
 You can now divide documents into sections and can set the page format and header and footer separately for
each section.
 You can use the options Document Tools[Header] > Different First Page and Document Tools[Header] >
Different Odd & Even Pages to assign different headers and footers to the first page or pages with even and
odd page numbers.
 In the case of documents with facing pages, you can now use mirrored page margins.
 If you are using custom page margins, the last setting is offered in the menu Design[Page Setup] > Page
Margins.
 If you apply a document template to a list, a multipage document will be created for the individual list
elements.
 Now you can drag a diagram for multiple data sets and drop it into a document.
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 Worksheets
 The option Maximize Pane is now available on the Cursor Tools/Cursors tab of the ribbon.
 A coordinates window inserted in a worksheet pane is now displayed as centered.
 Media
 The Media object player has been moved to a new "Media Foundation" technology, which supports a broader
range of video formats.
 You can now also set the time base of a media using the time of any still image and the frame rate.
 General Enhancements
 The additional shapes Rounded rectangle and Text box are available for drawing in diagrams and documents. A
text box is a text block that you can align in a rectangular box. You can assign a background color and border to
the box.
 Dynamically displayed alignment guides make it easier for you to align and scale shapes, diagrams and tables.
 Formatters for Roman numerals, alphabetical numbering, and Chinese and Japanese numerals have been
added in particular for table numbering and chapter headings.
 You can now specify a text in formatters that should be output for void values instead of a question mark.
 If you create a hyperlink to a document, you now have the option to provide the number of the page that is to
be opened.
 Diagrams, tables and documents are now centered when shown in the display window.
 You can now export diagrams, tables and documents directly to PDF.
 You can now set the preferred page layout for printing diagrams, tables, text and worksheets on the Page
Layout tab of the Properties dialog box.
 While an object is being updated in the background, an animated "hourglass" window now appears in the tab
of the object window.

New Analysis Features
 New Envelope Analysis Object
You can use the new Envelope analysis object to calculate the upper and lower envelope of signals. Three
different calculation methods are available (Maximum Slope, Peak Envelope or calculating envelopes with the
Hilbert transform).
 New Circle Approximation Analysis Object (FlexPro Professional)
The new Circle Approximation analysis object is included in FlexPro Professional 2019 as a powerful tool for
calculating roundness.
 New Sharpness Analysis Object (Acoustics Option)
With the Sharpness analysis object you can calculate the psychoacoustic sharpness of a sound signal.
 Enhanced Loudness Analysis Object (Acoustics Option)
The ISO 532-1 and ISO 532-2 standards are now also supported, and you can calculate the loudness over time for
time-varying sound signals.
 Enhanced Signal Analysis (Analysis Object)
 Two additional detrending methods are available for calculating the integral (moving average as well as DC
offset filter). These effectively prevent the signal from drifting during integration.
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 In addition to the trapezoidal rule (default), two additional higher order calculation methods (Simpson's rule
and cubic integration rule) are available for calculating the integral. This makes it possible to determine the
integral more precisely for smooth data sets with little noise.
 In addition to smoothing with a moving average, the smoothed derivative can now also be calculated with a
Savitzky-Golay derivative filter. The filter usually produces better results when calculating the smoothed
derivative, since higher frequencies are not suppressed like they are with the moving average.
 An additional higher order method for calculating the derivative is available (central difference quotients with
five sampling points). This calculation method is used in situations such as crash analyses and produces a more
accurate approximation of the derivative for smooth data. The default setting (central difference quotients
with three sampling points) corresponds to the calculation algorithm of the previous version of FlexPro.
 The area under the curve with zero crossings can now also be calculated as an absolute area.
 You can now also calculate the absolute value of the signal using the analysis object.
 Enhanced Signal Scaling Analysis Object
Two additional detrending methods are available (moving average as well as DC offset filter). These prevent the
signal from drifting when an adaptive trend is present. You can also use the object exclusively for detrending. For
this purpose, use the new Detrending entry in the Signal Analysis menu.
 Enhanced Signal Smoothing Analysis Object
 A Gaussian filter is now also available. It corresponds to a convolution with a normal distribution with an
adjustable standard deviation (width). The filter usually produces superior smoothing compared to smoothing
with a moving average.
 The Savitzky-Golay filter (moving polynomial approximation) now also allows polynomial orders smaller than 2
and larger than 6.
 Enhanced Statistical Quantity Analysis Object
Now all scatter dimensions and moments can also be calculated in blocks and floating. The parameters are now
all available as FPScript functions so that you can also easily use them outside of the analysis object.
 Enhanced Event Isolation Analysis Object
 With the added Void Values event you can search for void floating point values in data sets.
 The result options Extract values and Indices of the values now also work for a data matrix or signal series.
 Enhanced Instantaneous Quantity Analysis Object
This is another detrending method (DC offset filter). It prevents the signal from drifting (prerequisite for calculating the
respective instantaneous quantity).

 Enhanced Data Query Analysis Object
 The option Output selected items from previous data query is no longer available for the Keys of found objects
result because the values of the keys can change when the index database is updated.
 The additional criteria does not start with and does not end with are available when searching for text
attributes.
 When searching for formulas and analysis objects, you can now specify that the objects found in the first step
should be updated and indexed first before applying other search criteria that refer to the data.
 You can now set the result and output format separately for the data query. You can output the data as a list,
bundled or concatenated. When concatenating signals you can now choose whether the X values should be shifted or
not.

 General Enhancements
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 In the case of non-linear curve fitting, model ranking can now be aborted prematurely.
 All analysis objects now output an error message if at least one of the required data sets was not specified on
the Data tab.
 In the Properties dialog box of data objects, the header data currently assigned to the result is displayed as
placed in the corresponding input fields.
 The dialog box that appears when using drag-and-drop to add a data set to the FPScript formula with
arguments (function) has been redesigned.
 The final result of a formula that you run in the debugger is now no longer in a dialog box, but instead appears
in the Watch window.
 You can now directly debug an FPScript formula with arguments (function). A dialog box appears in which you
can specify the arguments.

Data Cursors
 The perpendicular and dimensioning line dimensions are now provided in the menu for both directions.
 You can now restrict the tracking of the image section horizontally or vertically.
 The attributes Visible, Autoscale and Cursors can now be set directly on the Cursor Tools tab of the ribbon.

FPScript Programming Language
 Break Statement
Use the new Break statement to end a loop prematurely.
 2D Index
Use 2D Index to extract any scatter data from a data matrix or signal series.
 New FPScript Functions
Function

Description

CoefficientOfVariation

Calculates the absolute or relative coefficient of variation for a data set.

CrestFactor

Calculates the crest factor for a data set.

ConvexHull

Calculates the convex hull of a two-dimensional point set.

DCRemovalFilter

Removes the DC offset (DC bias) with the help of a digital (recursive) high-pass filter.

Diff

Calculates differences of neighboring Y values as well as right and left-hand difference
quotients.

GaussianFilter

Filters a signal with a Gaussian normal distribution. Typically used for smoothing and as
a filter for analyzing roundness.

Kurtosis

Calculates the kurtosis or excess for a data set.

LeastSquaresCircle

Calculates the least squares circle (LSCI). Used to determine roundness.

MaximumInscribedCircle

Calculates the maximum inscribed circle (MICI) of a two-dimensional point set. Used to
determine roundness.

MeanSquaredError

Calculates the mean squared error for a data set.

MinimumCircumscribedCircle

Calculates the minimum circumscribed circle (MCCI) of a two-dimensional point set.
Used to determine roundness.

MinimumZoneCircle

Calculates the reference circle of the minimum zone circles (MZCI) of a twodimensional point set. Used to determine roundness.

SavitzkyGolayDerivative

Calculates the derivative of a data set with a Savitzky-Golay smoothing filter (least
squares derivative). Effective method for determining the smoothing derivative of a
noisy data set.
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Function

Description

Sharpness

Calculates the sharpness of a sound signal.

SearchStrings

Searches in a data series for a string and returns the indices of the matches as a data
series.

Skewness

Calculates the skewness for a data set.

StandardDeviation

Calculates the standard deviation for a data set.

StringReverseFind

Searches for the last match in a substring and returns its position.

IndexSort

Sorts an index data set to be ascending.

LeastSquaresCircle

Calculates the least squares circle (LSCI). Used to determine roundness.

AssignListElementNames

Assigns element names to one or more elements in a list.

PolarTransform

Carries out a polar transformation.

 New FPScript Properties
Property

Description

AssignHeader

Read access to the header information attribute of a data object. Read/write access to
the header information attribute of the current formula.

 Enhancements to existing FPScript functions and operators
 The FPScript functions for calculating statistic quantities AbsoluteDeviationFromMean and

AbsoluteDeviationFromMedian have been expanded to include the ability to calculate the quantity in blocks or
floating.
 The Derivative function now also supports a higher order calculation method (central fourth order difference

quotients). This calculation method is used in situations such as crash analyses and produces a more accurate
approximation of the derivative for smooth data. The default setting (central second order difference
quotients) corresponds to the calculation algorithm of the previous version of FlexPro.
 The calculation algorithm of the Derivative function has been changed at the boundary points as well as for

unevenly spaced data sets. In these two cases more accurate results are obtained when calculating the
derivative.
 The ImpulseToFrequency function can now be applied to step signals (incremental signals).
 The Integral function has been enhanced and now supports two additional higher order calculation methods

(Simpson’s rule and cubic integration rule) in addition to the trapezoidal rule (default). This makes it possible
to determine the integral more precisely for smooth data sets with little noise.
 The syntax of the SavitzkyGolayFilter function has been changed. The second argument (smoothing width)

replaces the old syntax, where the left and right side smoothing width had to be specified individually.
 The third argument of the SavitzkyGolayFilter function now also allows the input of polynomial order 0

(corresponds to moving average) and 1, as well as orders greater than 6.
 The SavitzkyGolayFilter function has been expanded to include an additional argument and now also supports

more precise calculation of the smoothing filter at the boundary points (but requires a higher numerical
effort). The default setting corresponds to the marginal calculation of the previous version of FlexPro.
 The Loudness (Acoustics Option) function supports the additional standards ISO 532-1 and ISO 532-2 and

various input data types.
 You can now also use the channel name as a character string as an argument for selecting the element of the

ReadDataFile function to be imported as an alternative to the element index.
 When accessing two-dimensional data sets, you can now combine the Value Index Operator and Index

Operator as needed.
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 The ListElementName function has been renamed to ListElementNames and now also accepts a data series

index for indexing multiple element names. If no index is specified, all element names in the list are returned
as a data series.
 To create a list of objects easily, you can now use the placeholders '*' and '?' in the path name. For example:

'\Measurement*\Signal' instead of [\Measurement1\Signal, \Measurement2\Signal, ...].
Use the '*' placeholder for a string of any length and the '?' placeholder for a single character.
 In all FPScript functions for event isolation, such as the Extrema function, you can now also use the options

EVENT_INDEX and EVENT_EXTRACT for a data matrix or signal series. The new FPScript 2D index is used for
this.
 The functions SearchValue and SearchVoidValues can now also be used for a data matrix or signal series.
 The DeltaCompress function behavior has been changed for EVENT_SETVOID mode. Now the values omitted

by compression are set to void. This behavior is the same as that of the other event isolation functions. You
can adapt your FPScript code to the current version by either adding or removing the EVENT_COMPLEMENT
option.
 The Execute function now includes an optional argument that you can use to control whether formulas

referred to by the FPScript code to be executed are updated before execution.
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